issue#27: >november 2008

PCLOS >digital magazine

INCLUDING

- Linux Media Player Roundup 5
- HowTo: Samsung ML-2510 Laser Printer
- Composite Manager Crashed Twice!!

FEATURE: PCLinuxOS on a USB Stick

www.pclosmag.com

PCLOS based Distro
Letter from the Editor:

It's almost Thanks giving where traditionally is served Turkey, stuffing, mashed potatoes and cranberry sauce. Yum! Thanks is given for many things at this time of year and we all can be thankful for such a great distribution in PCLinuxOS.

We at the magazine want to thank all the developers and contributors for giving to PCLOS and making it a great distribution! I want to thank all the Magazine staff for making this magazine a great magazine!

This month we have another exciting issue with the main Article being about PCLinuxOS on USB. Enjoy and Happy Thanksgiving!
http://creativecommons.org/licenses/by/2.0/
or send a letter to Creative
Commons, 559 Nathan Abbott Way, Stanford, California 94305, USA.

This guide has been modified by Papawoob to reflect the Linux distribution of PCLinuxOS 2007.

Chapter 8: The World Wide Web (WWW)

The Internet has much to offer in terms of information on almost any subject matter imaginable and interaction with people and organizations from all over the world. Much of this access and interaction makes use of the environment which is popularly known as the World Wide Web (WWW) or web. The WWW is an interlinked network of systems, called web servers, offering multimedia services and information. A user can access these using what is known as web browser software.

The Mozilla Firefox Web Browser

Firefox is a full-featured integrated web browser, news reader and web page composer program, and is the default web browser for PCLinuxOS 2007. Using Firefox a user can be exposed to the richness and diversity of multimedia content and services available on the WWW.
Firefox is a relatively lightweight and fast browser. The most distinguishing and advantageous feature is the sheer number (literally thousands) of extensions (add-ons) that can be downloaded and installed. Using these add-ons, the user can personalize Firefox exactly how they want Firefox. For more information and descriptions of the over one thousand available add-ons, take a look at: http://www.Firefox.com/firefox.

To start Firefox, click on the Firefox icon on the panel or launch the application from the menu system:

Main Menu -> Internet -> Web Browsers -> Mozilla Firefox

By default, the web browser component of Firefox will be executed and displayed. The navigation window has the following main parts by default.

the navigation toolbar
the menu bar
the display panel
the side bar (optional)

(Firefox has many features and only a brief description of its main functions and features can be given here. The user should refer to the Help button on the menu bar for more details.)

**The Navigation Toolbar**

The navigation toolbar allows you to access a website by entering its Uniform Resource Locater (URL) or more informally known as its web address, e.g., http://Distrowatch.com, in the address box provided. Actually you need to enter only the name of the host i.e., “Distrowatch.com” and Firefox is smart enough to figure out that you want to access the web server on that host.

Clicking on the arrow at the right edge of the address box will open a pull-down menu showing a history of websites visited previously. You can click on an entry in
the list to select that website.

Also present on the navigation toolbar are the Back, Forward, Reload and Stop buttons.

The Back button enables you to go back to the previous web page displayed.

The Forward button enables you to go forward to the next web page that you have already accessed.

The Reload button forces Firefox to re-access the website and load the current web page.

The Stop button halts the loading of a web page that is currently proceeding.

Next to the address box in the navigation toolbar is the Search button. This button enables you to perform searches for relevant web pages on the Internet by making use of the Google search engine. To search for some particular information, you can enter the keywords for the search into the address box and then click on the Search button. As you type each letter a list of possible searches will be displayed below the search box. Quite often, what you are searching for will show up in the list before you finish typing. If so, simply click on the one you want to try. The results of the search will be displayed in the display panel. You can configure the search engine to use with this search button in the Firefox configuration setup (see Configuring Firefox below).

**The Menu Bar**

FILE EDIT VIEW HISTORY BOOKMARKS TOOLS HELP

The menu bar has several menu buttons. Clicking on one will open up a drop-down menu selection where selected operations can be performed.

The File button caters to the performance of file level operations like the printing and saving of web pages, the opening of web pages, files etc.

The Edit button allows you to find strings of text on the displayed page as well as to edit the Firefox configuration to your personal preferences.

The View button allows you to control the viewing of the various toolbars as well as the zooming of text and full page display of the display panel. The HTML source
manage your bookmarks and personal folder. You can add frequently visited sites to the bookmark and/or personal folder. To manage and organize your bookmarks you can select the "Organize Bookmarks" item in the drop-down menu.

The bookmarks can be organized into folders by dragging and dropping them into the desired folder. New folders can be created by clicking on the New Folder button at the top. Folders can have a name and description. To separate and group together related folders, a separator line can be drawn by selecting the "New Separator" button.

The Tools button enables you to navigate and use specific tools and add-ons in Firefox.

The Help button contains the Firefox help files arranged in user-friendly web page style and format.
The Side Bar

Under the View button you will find an option to add a side bar. The Side Bar is displayed on the left of the main display panel. This side bar can display your History, or your Bookmarks for quicker access.

The side bar can be turned on/off by selecting from the main menu at the top,

View -> Sidebar

The Main Display Panel

This is the area where the contents of a web page are rendered and displayed. This display area can be made full screen by either selecting the View -> Full Screen selection from the top menu bar or pressing the F11 key. To disable full screen display either press F11 again or click on the "Restore" window button on the top right corner of the menu bar.

Navigation Tab Bar

Firefox allows you to browse multiple websites within one browser window by using navigational tabs. This overcomes the inconvenience of opening several windows under Firefox to view multiple sites. To do this, either choose under the menu bar:

Edit -> Preferences ->Tabs ->New Pages Should Be Opened In ->A New Tab

or enter CONTROL-T.

If you open different web pages using this navigation tab feature, they will all be displayed under the same window. You can then use the tab bar to move between each tab screen.

Configuring Firefox

Firefox is highly configurable. To configure Firefox, select from the main menu:

Edit -> Preferences
The categories available for configuration are listed on the top panel of the main configuration window as seen below:

have images load automatically, and control Javascript. You can also set your default fonts and configure how Firefox handles different file types.

The Feeds tab allows you to choose which feed reader to use when accessing live feeds from the Internet.

The Privacy tab lets you manage your History, Cookies, and Personal Data.

The Security tab allows management of passwords for different websites, warning messages, and whether websites are real or not.

The Advanced tab lets you control encryption, updates, and navigation within web pages.

**Exercises**

Start up the Firefox browser and visit the websites listed below. Use the navigation tab bar feature so that you open up the websites all in the same window, but under different tab pages.

www.Firefox.org
www.yahoo.com
Using a Portal

The term portal is used to denote a website that acts as an gateway for providing information about a subject area or group of subjects. From this portal site, information as well as links to other sites providing information about the topics in question may be found. Portals are useful starting places for new web users who do not know where and how to go and look for information about a specific topic or subject.

Many major ISPs provide portal-like information services for their subscribers so that if the latter make this their home page for their web browser, on launching their browser the ISP's portal page is opened. The subject areas covered by these ISP portals are typically subjects of general interest like shopping, local and foreign news, entertainment etc.

Other portals offering general information as well as links to other more subject-specific portals and websites include:
Yahoo (www.yahoo.com)
Netscape Network (www.netscape.com)
Microsoft Network (www.msn.com)
Angelfire (www.angelfire.lycos.com)

Using an Internet Search Engine

While portals provide a guided and categorized means to access information, sometimes we want to be more specific about the topic we want to find and portals generally are not able to provide this in a timely and efficient manner. An alternative is to utilize a search engine.

A search engine, as the name implies, allows you to query it about some specific subject and it will try to retrieve links to web pages and resources which contain information about the subject matter being queried.

The popular search engines available are:

Google (www.google.com)
Altavista (www.altavista.com)
Lycos (www.lycos.com)
Yahoo (www.yahoo.com)

There are also sites which allow you to search using more than one search engine, e.g.

Search.com (www.search.com)
Easysearcher (www.easysearcher.com)

Search Basics

While each search engine will have its own technology, its utilization to perform a simple and basic search is essentially the same, irrespective of which search engine is used.

To use a search engine for basic searches, you just type in a few descriptive words about the item/subject you are searching for. It will return to you a list of links to web pages and resources which contain all the words in the query string. Note that common words like "the", "a", "how", etc. are usually ignored by the search engine unless specifically told not to. Words are also not case sensitive unless enclosed by quotation marks. To refine and narrow down your search, you will need to add more words to the search terms you have already entered. Your new query will return a
make efficient use of them.

Example

In this section we shall show an example of how to use a search engine.

In this example, assume that we have heard from a friend that she has been diagnosed with a foot condition in which her forefoot is in pain and there is numbness as a result of poor blood circulation in one of the toes. We also remembered her telling us that the doctor named the condition as Freiberg disease, or some name which sounds like that since the telephone line was not too clear.

Initially we try entering the following keywords, "foot pain", in the search engine.

As can be seen from the results of the search, what we got back was very general and we need to go through each of these links to check if it contains relevant information or links to relevant information. We can narrow down the search if we are more specific about where in the foot the pain is, e.g. "forefoot
pain.” This will give us better results, but the list of hits is still long.

If we remember that the friend mentioned that the doctor gave the name of the condition as something sounding like Frieberg disease, we can try searching for this specific term. The search results improve immediately as can be seen below and in this particular example we have found several links which are directly related to the information we want.

That is the end of this chapter in our journey into the inner workings of KDE and PCLinuxOS 2007. In our next chapter we will be covering all of the ins and out of Internet e-mail including how to setup an e-mail account, manage your mail, and a couple of different e-mail clients. See you next month!
**Problem**

When I changed some window settings accidentally I got the KDialog error message “The Composite Manager crashed twice...” and the system was slow and had funny shadows.

**Answer**

Open KDE Control Center (PC > System > Configuration> Control Center) and navigate to Desktop > Window Behavior > Translucency. Remove the tick on “Use Translucency/shadows”. Click APPLY and restart the computer.

**Vince**

The correct .ppd drivers for Samsung ML-2510 monochrome laser printers to run with HPJet Direct are not installed in PCLinuxOS by default.

Download driver from Samsung website (link: http://www.samsung.com/us/support/download/supportDownDetail.do?group=&type=&subtype=&model_nm=ML-2510/XAA&language=&cate_type=all&mType=DR&dType=D&vType=L&ctlID=1075290&prd_iacd=&disp_nm=ML-2510). Choose to “save” the file, and select a location, for example: “/home/me/downloads/samsung”.

Extract the file (20080926112651265_UnifiedLinuxDriver.tar.gz) by right clicking and selecting “open with Ark”. Run the extraction process and choose (in the example given above) the “Samsung” folder, or wherever you prefer. But DO make sure to note where you expand the contents of the original file. At that location you will find a folder named “cdroot”.

Now you need to copy only two files from this unzipped folder to specific folders on your system.

You have to be root to do this – so open Konqueror as root – PC > System > File Tools > File Manager Super User Mode

The first file is named “rastertosamsungsp!”
On my system navigate to (depends where you downloaded and extracted the files):
/home/me/downloads/samsung/cdroot/Linux/i386/at_root/usr/lib/cups/filter/rasteertosamsungspl

Select and copy the file to clipboard.

Then navigate to /usr/lib/cups/filter - and paste the file here

The second file is named: “ML-2510spl2.ppd”

Navigate to:
/home/me/downloads/samsung/cdroot/Linux/noarch/at_opt/share/ppd/ML-2570ps.ppd

Select and copy the file to the clipboard.

Then navigate to /usr/share/cups/model/samsung - and paste the file there.

Now restart your computer and do a normal printer install with CUPS – using Firefox browser > url (localhost:631).

Vince

Last month we showed you how to install VirtualBox So it might be a good idea to use it to try out some vdi images (ready made image for Virtualxox)

http://www.veedeeyes.com/veedeeyes/VirtualBox+PCLinuxOS+2009+Beta+1+Virtual+Disk+Image
http://www.veede-eyes.com/veedeeyes/TinyMe-2008.0-VDI
http://www.veede-eyes.com/veedeeyes/pclos-gnome2008.1
http://www.veede-eyes.com/veedeeyes/PCFluxboxOS-TinyFlux-1.0

VDI Instructions:
http://www.veedeeyes.com/veedeeyes/GettingStarted
Welcome to Part 5 of our Linux Media Player Roundup! We'll be going over several more media players for you to consider. First, I wanted to let everyone know that I've done a little cleanup on part 1 of this article series. Looking back not too long ago, it dawned on me that I didn't give BMPx a fair shake when I reviewed it the first time, so I've gone ahead and updated the review with a much more detailed overview of the player.

For those of you waiting for me to get to the couple of players I missed earlier in the series (speaking alphabetically of course), I'm working on getting my hands on them for testing and should have them reviewed no later than my posting of part 8, which is looking to be the 19th of December. Which to me is kinda nice. It means we'll finish this up before Christmas. :) Now, on to the next part of our roundup of Linux media players.

Noatun

Noatun is a KDE music player apparently designed to be the little brother to Juk, Amarok and Kaffeine because it really doesn't do much more than either Juk or Kaffeine does, and in fact, in many ways does less. It's so redundant in so many ways to what those other two offer, that if you took both of them, mixed them together into a pot and ladled out half the features, you'd have Noatun. I really didn't find anything that made it stand out from the rest of the media players, or even anything that separated it from its two big brothers.

One thing it does claim to have as an advantage is its purported wide ranging support of media formats. If you have a codec or a plugin installed on your system (not within Noatun) that will decode a given format, including video formats, Noatun can play it.

It does this by handling the various media formats through external plugins and codecs like Windows does rather than internally like most Linux players do. While this provides you with some great flexibility in the program, it can also create some rather ugly headaches for you as well. It does support wav, ogg and mp3 natively, but the rest is kinda up in the air. One thing that might be considered an advantage though is it's very small footprint. This comes from the minimalist interface it employs. However, for those liking multiple playlists, this won't work as a good media player because it only supports one playlist at a time.
Noatun is skinable, and supports all Winamp and XMMS skins. It also supports visualizations through the plugins system. If you have an iPod and hope to have compatibility with Noatun, you’re out of luck. Noatun has no support for any external media players. Also, if your music collection is large, it may be a good idea to avoid Noatun, because during testing, it choked to death on my 2500+ song collection.

For those wanting to try Noatun, it’s written for and available by default in KDE, or via the KDE multimedia package. A word of warning though: at this point in time, Noatun only works with the Linux aRts sound system. So if you’re using some other sound system such as Alsa, Noatun won’t run for you, instead erring out upon loading.

The Ogle DVD Player is a specialized Linux media player whose sole purpose in life is just to play DVD's and nothing else. It's also the very first Linux media player to fully support DVD menus as evidenced in the screenshot. It's a little tricky to get installed on some systems, so be aware of that in advance. It's very simple and straightforward to use, with no need for configuration by the end user. Just pop in your disk, open Ogle, and away you go. It won't play everything, but what disks it can play, it does a good job at. It also has a feature that'll allow you to read DVD vob files right from your hard drive, but currently that feature is broken.

The DVD menu system works very well on the player, allowing you full access to all menus, extras, and even some of the really obscure stuff on the DVD. You won't find any extras on the player though outside of the buttons you see on the screen. The actual executable hasn't changed any since November, 2003 when 0.9.2 was first introduced, however, a few updates of libdvdread, the core plugin that reads and decodes DVDs, has seen a couple of updates itself. I couldn't seem to get it to do full screen, but other than that, it worked as designed. For more information on this player, please see the Ogle DVD homepage.
Quod Libet

Quod Libet, Latin for "What Pleases" is a Linux audio player designed for Gnome, written in Python and based on GTK+ with the primary goal to provide an easy way for users to organize their music in whatever way they want to.

Initially when I fired it up, I found it to be rather plain. Like a stripped down version of Noatun. It's also not terribly intuitive, even though it looks like it would be. However, once you get digging into the library, it's interesting to find out the vast amount of sorting and management power you have in your control.

As a media player, it really isn't anything special, and really is less than special. It's the library that makes it so special and unique. And believe me, the things you can do in the library are incredible. Only real thing I found wrong with the library though was that you couldn't rebuild the library, or import new tracks. "I actually moved on to look at another player for a while, and oddly enough, during my fussing with and reloading the library in the other player, "it built the library in Quod also". So I have no idea where Quod is taking its library from, but it may be queuing itself off something in the operating system itself, which may be part of how it's able to allow you to do so much complex management of your music collection.

Not being able to directly import songs into Quod without first having to add them to the master system library (if that is in fact what it's doing) seems to kind of defeat any tiny advantages the player had. Really it wasn't all that great a player, but the library features and the management it offers to your music collection was very impressive. So I'd say it's less a player and more a music manager than anything. It does have a plugins system to allow you to change or improve how it does things, but I couldn't find any plugins for it, so that made the whole plugins system completely moot in my opinion.
RealPlayer

I'm sure there's a lot of Linux users both surprised and aghast to see Real Player mentioned here. But yes, Real Networks does produce a multimedia player for Linux, and has for quite some time. The software is still proprietary like it's always been, which might turn off a lot of born-in-the-blood Linux users. However, it does have a redeeming feature, if you can call it that. It allows you to effectively play real audio streams or files on your Linux machine. It also has limited mp3 and wav support, but no playlist support. It will also play real media videos, as well as flash, AAC, AU, MP4, AU, OGG, and some other really off the wall formats you're not likely to ever see but maybe once in your entire lifetime, if ever. However, just because it says it can, doesn't mean it can. I went through and tried everything I could, and threw every possible file I could at the player, and it only seemed to ever play ogg, mp3 and RM/RAM files, nothing else. So all that supposed file support was total hogwash.

It did slightly redeem itself during my testing. When testing streaming real media files, it loaded and played those without a problem via the browser plugin it installs during setup, so at least you could listen to real media streams in your browser if you wanted to and not have to worry about fighting any other players to get them to do it instead. Is RealPlayer a good media player for day to day use? Not a chance.

But, is it good for those few rare times when the only choice you have is either listening to a Real Media stream, or nothing at all? I'd say yes. As odd as that sounds, there are times when a proprietary player does in fact do a better job at handling a niche item under Linux than any open player. Thankfully not very often. This just happens to be the exception.

Anyhow, there's a lot of other things that RealPlayer is supposed to be able to do, but unlike it's Windows counterpart, the advertised features, such as CD ripping, media library, the music store and more were not there. All I found was the basic player and nothing more. But since you won't be using RealPlayer on your machine for really anything other than playing the odd and occasional Real Media stream, that's not all that big a deal.
RealPlayer is available via your favorite local repository.

Summary

That's it for part 5. In part 6 we'll be starting off with Rhythmbox, a media player that I've really been hearing a lot about (and requests to include) since the start of this series, and it's one that's really caught my interest because of that. I'll also be covering a couple other media players some of you have been clamoring for. Stay tuned!
PCLOS, my new pocket OS

Author: pinoc

PCLOS everywhere: on my desktop, my workstation, my laptop, and several PCLOS Live-CDs to show off, work with and promote PCLOS to my friends. Yet, one option was missing in my PCLOS collection: a fully functional PCLOS installation on an external USB device; all my documents, bookmarks, programs, personalized settings, etc. working and running from a small USB device. You have your own PC in your pocket! Boot it from any standard PC, regardless of its operating system, just use its keyboard, mouse, and graphic display and you are right at home on your own PCLOS installation. I know that others managed to set this up and of course I already tested the option 'install to USB device' at the beginning of the MiniME Live-CD installation but until recently this never worked out. Finally I figured out why and this article summarizes the steps to get you up and running. The following USB-devices were used for this article (figure 1): OCZ ATV (32GB flash drive), Corsair Flash Voyager GT (16GB flash drive), LaCie Mobile Hard Drive II (250GB, 2.5" slim external hard drive).

Figure 1: The testbed of external USB devices: 2 sturdy flash drives with fast write performance: OCZ ATV (32GB) and Corsair Flash Voyager GT (16GB) and the external slim LaCie Mobile Hard Drive II (250GB, 2.5").

External USB hard disks are rather cheap now, providing ample disk space, and the USB2 port is fast enough to boot and perform with similar speed to a standard PCLOS installation on an internal hard disk. In this sense a PCLOS installation to an external USB hard drive is the cheapest and most minimalistic PC configuration you can think of. It is more portable, smaller, and cheaper than any netbook. Moreover, virtually all newer laptops and desktops come pre-installed with Windows Vista, a splendid operating system because it provides us the very latest hardware, tons of RAM, and fuels our desire to startup any different OS we can think of. So, go ahead, attach and boot your external USB hard disk and use all the great Vista compatible hardware of the 'slave' machine with a decent OS! Take your PCLOS hard disk to
your friends and quickly show them how nice and especially fast their new Vista-PC could be. And of course we all love the idea to carry our own system on a USB stick!

But before we start, please realize that the steps described in this article should be considered as a feasibility study and should not be applied to any viable data you have! This article is based on experience with the described USB devices and my three PCs and it may or may not work for your hardware components. But if you have a spare USB-drive a non-critical PC to play with you might want to give it a try. All this was lot’s of fun and I am using my external Linux hard drive for one week now without any issues. But of course I would not recommend putting all your data to an external hard disk and getting rid of your PC. Please make sure to have and to keep backups of all your data and software at any time!

1) Introduction

When working in a mixed Windows/Linux environment it makes sense to have one partition of the USB device in NTFS format. In this way you can still use your device as a storage disk and have easy access to it when connected to a Windows machine. In fact there is another reason why you should have a Windows partition on your flash drive: Installing PCLOS to a USB device implies that you will have more than one partition. When plugged into Windows, Windows Explorer will automatically assign a drive letter to the first partition of the device. If the device is a hard drive, Explorer will list it under 'Hard Disk Drives' and if it is a flash drive it is listed under 'Devices with Removable Storage'. The disk management in Windows XP does not permit partitioning a flash drive (However, it was possible to setup more than one partition on an external USB hard disk in Windows). If you partition a flash drive in Linux and the first partition is not of type FAT or NTFS, Windows does not recognize and consequently can not display the content of the first partition. Furthermore you can not access or read from any other partitions on the flash drive, even if they are formatted in NTFS or FAT. And to make things even worse, a double-click in Explorer on the first partition with a Linux file system on a flash drive will 'offer' you to reformat the entire flash drive. Figure 2 summarizes this situation for the
first partition: root ext3 3.88GB, second partition: swap 1.02GB, third partition: NTFS 24.97 GB. The purpose of the third partition (NTFS) was to act as a common data share between Linux and Windows but apparently this did not work as expected. Moreover, you can expect the same behavior in Windows XP for a USB-device having only Linux partitions. In order to first, avoid the common Windows user behavior quickly clicking OK, OK, OK, to destroy our flash drive Linux installation, and to second, maintain a common data partition for storage, we will setup the flash drive’s first partition as NTFS. Alternatively you could use the inferior file system FAT32 but with ntfs-3g we now have safe write support in Linux for NTFS formatted file systems.

2) Installing PCLOS to a USB device

The installation of PCLOS to an external USB drive (flash drive or preferably to an external hard drive) is described in the following sections. Most of the instructions require root privileges and if applied in the wrong way they can damage your Linux installation on the PC or your USB device, or render it unbootable. The steps are described to the best of my knowledge but I can not accept any liability whatsoever for any error, or for any loss or damage arising from using the following instructions. Use them at your own risk!
2.1) Preparing the USB-device

First we need to prepare the USB drive for the installation of PCLOS. In the following steps I use the 16GB Corsair USB flash drive which comes pre-formatted with a single 15GB FAT32 partition: Attach the device to a running PCLOS system. PCLOS should show a new pop up window for the new drive with the option 'Open in New Window' pre-selected. We click on 'OK' to let PCLOS auto mount the device. Next, a new Konqueror window will open and display the contents of the newly attached device. The location bar of this new Konqueror window shows the mount point of the USB device. In my example this is sdc1, meaning the first partition of the disk sdc. Make sure to remember, or better, write down the disk device notation of the USB device, here sdc. Now close this Konqueror window, start the PCLinuxOS Control Center (PCC), goto the disk partitions menu, and ensure to select the tab of the external disk device (here sdc). In my example I click on the single existing partition of the 16GB Corsair flash drive which shows up as a FAT32 formatted mounted partition (figure 3 left). Now, to partition the device we first unmount the partition (click on 'Unmount'), then we click on 'Toggle to expert mode', and finally choose 'Delete' to have a completely unformatted empty device (figure 3 right).

**Figure 3:** Diskdrake in PCC showing the 16GB Corsair flash drive in its original state (left: one FAT32 partition) and unpartitioned (right).

Next, we select 'Create' and define the first partition (sdc1) as NTFS (or if its already installed as NTFS-3G) without a mount point (figure4 left). In the same way we use the remaining free space on the device to setup the second partition (sdc5) as ext3 and the third partition (sdc6) as Linux Swap, none of the partitions should have a mount point specified. Now that we have specified the partitioning layout we need to select each partition and click on 'Format' to write this layout to the USB device. After that
we click the 'Done' button to exit the partitioning tool. PCLOS will show up a new window asking to write the changes to /etc/fstab (figure 4 right). Here, we click 'No' since we will use the USB device on a different machine and we do not want to modify the existing fstab file of the running PCLOS system!

**Figure 4:** Partitioning the 16GB Corsair flash drive: first partition NTFS, second ext3, and third Swap. When done select 'No' to maintain the existing fstab file of the host machine.

The USB device is now prepared for the installation and we can detach it from the system. A quick test on a MS-Windows PC confirms that we can use the first partition perfectly fine as an external storage device with full read/write access.

### 2.2) Starting the Installation

Boot the MiniME Live-CD on any PC and login into the root account. Attach the newly formatted USB-device and in the following popup windows select 'Cancel' to avoid auto-mounting the USB device partitions. Click the 'Install PCLinuxOS' icon on the desktop, in the next window select 'USB Hard drive' as installation type and then 'Custom disk partitioning'. In the following window make sure to not select your existing hard drive(s) but to select the correct tab for the USB drive. It should be the right-most one and displaying your previously created partitioning scheme.

Remember or better write down the disk device name, in my case the test machine (my laptop) has only one disk (sda) and consequently the attached USB-drive is listed as sdb. Select the second partition of the USB device, (our USB system root partition (/), ext3, sdb5), click on 'Mount point' and select the root directory '/' (figure 5). Don't do anything else, just click on 'Done' to finish the partitioning dialog, keep all the defaults in the next windows and simply click on 'Next' to let PCLOS format the root partition and perform the installation to the USB device.
the next window (right) on 'Next' to start the installation.

Don't get in a hurry, and just click next, when the window with the bootloader installation appears. Here you must change the location for the bootloader from the default of the PC's own hard drive (usually sda) to point to the USB device instead. Open the dropdown menu next to 'Boot device' and select the USB device, not a partition of it, so in our example use sdb and not sdb5 or the like (figure 6 left).

Figure 5: The 16GB Corsair flash drive (sdb) during the PCLOS MiniME Live-CD installation. The second partition (ext3) will become the Linux root partition and is assigned the mount point '/'. Click on 'Done' and in

Figure 6: above: Be sure to install the bootloader to the USB device (here sdb)! On the left image the dropdown menu of the 'Boot device' is overlaid and shows the correct bootloader location entry. Right: The final list of the boot menu which will be corrected later on.
2.3) Making Grub work

Attach the USB device to a running PCLOS system and select 'OK' to have PCLOS auto mount the partitions of the device. The first Konqueror window shows the first partition of the USB-device (NTFS) and the second Konqueror window shows the second partition, the freshly installed Linux directory tree of the root partition (/) on the USB-device (sdb5, figure 7).

To correct the bootloader on the USB device (not the one from the host machine!), open a new Konqueror window and go to /media where you should find a directory named disk (could also be disk-1), which is the second partition on the USB device with the identical content as shown in the Konqueror auto mount window in figure 7. Become root and use your preferred text editor to open the file:
timeout 10
color black/cyan yellow/cyan
gfxmenu (hd0,4)/usr/share/gfxboot/themes/pclinuxos/boot/message
default 0

title PCLOSUSB
kernel (hd0,4)/boot/vmlinuz BOOT_IMAGE=linux root=/dev/sda5 acpi=on resume=/dev/sda5 vga=788
initrd (hd0,4)/boot/initrd.img

title PCLOSUSB-nonfb
kernel (hd0,4)/boot/vmlinuz BOOT_IMAGE=linux-nonfb root=/dev/sda5 acpi=on resume=/dev/sda5
initrd (hd0,4)/boot/initrd.img

title PCLOSUSB-failsafe
kernel (hd0,4)/boot/vmlinuz BOOT_IMAGE=failsafe root=/dev/sda5 failsafe acpi=on resume=/dev/sda5
initrd (hd0,4)/boot/initrd.img

Figure 8: Boot menu file menu.lst of the USB device corrected to point to the USB boot device sda.

Finally, don't forget to save the file menu.lst located on the USB-device.

In the last step, we must correct the file system table which right now still points to sdb instead of sda. As root, use your preferred text editor and open the fstab file on the USB-device: /media/disk/etc/fstab.

The last group of entries (in our case sdb) are the ones from the USB device during the installation and the entries of the previous group (in our case sda) are from the installation machine. We must remove all entries from the installation machine (sda)
and rename all entries from the USB device from sdb to sda to make the corrected bootloader find the appropriate partitions in the corrected locations, namely on sda. In addition we also remove the entry to the first NTFS partition on the USB device which will be setup later in a different way. For now, we only keep the required corrected entries to allow booting the USB device. The final result should be similar to figure 9 below, note the commented original sdb entries which have changed to sda.

```bash
## fstab created by Livecd-install.
none. /proc proc defaults 0 0
none. /dev/pts devpts mode=0620 0 0
none. /proc/bus/usb usbfs defaults 0 0

# cdrom: MATSHITAJU-841Db
#. /dev/hda /media/cdrom auto user,exec,ro,noauto 0 0

# /dev/sdb5, size=22323168, type=131: Journalised FS: ext3 (extended)
/dev/sda5 / ext3 noatime 1 1

# /dev/sdb6, size=2228192, type=130: Linux swap (extended)
/dev/sda6 swap swap defaults 0 0
```

**Figure 9:** Partition table file fstab of the USB device corrected to point to the USB boot device sda.

Finally, don't forget to save the file, fstab, located on the USB-device.

Quit all Konqueror windows, unmount or safely remove the USB-device, and detach it from the PC.
2.4) Finalizing the Installation

Attach the USB device to a PC where the BIOS is set to permit booting from an external USB-device, switch on this PC and you should now boot your PCLOS installation on the USB-device. Since this is the very first boot we need to finish the installation by providing a root password and setting up the user account. Login into your new USB system, setup your Internet connection (usually DHCP works almost everywhere), install/update your favorite programs with Synaptic/Smart, setup Firefox with your bookmarks, and may even put your documents/images/music on the USB flash drive or hard disk. To gain full access to the first NTFS partition on the USB device become root and create a new directory, for example using the command

```
$ mkdir /mnt/usb_ntfs
```

Next, open Synaptic/Smart and install ntfs-config. This will install all necessary tools to allow the NTFS-3G driver to provide you full read/write access to your NTFS partition on your USB device. As root, use your preferred text editor to open the fstab file on the USB-device: /etc/fstab and add the following line at the end of this file:

```
/dev/sda1 /mnt/usb_ntfs ntfs-3g defaults,locale=en_US.UTF-8 0 0
```

Save the file and after a final reboot you should be able to use this first NTFS partition on your USB device as a fully accessible data share directory from your USB Linux installation as well as a normal external storage device when plugged into a MS-Windows system. When logged in the user account, the NTFS and the system partition of your USB device can be accessed easily by clicking the respective USB drive desktop icon named 'Removable media'.

3) Advanced settings

How about 3D-acceleration?

The xorg.conf as generated on the PC used for the USB installation is specific to the hardware of that PC (i.e., my laptop) and may not work on other PC hardware. It is thus a good idea to keep a backup copy of this xorg.conf as for example xorg.conf_mylaptop in your home directory.
For 3D acceleration on a PC with an NVIDIA graphic card (i.e., my desktop), boot the USB device on such a PC, install and configure the proprietary drivers in the usual way, and once everything is working fine keep a backup copy of the new xorg.conf as xorg.conf_mydesktop in your home directory. Similarly, you can setup an xorg.conf_ati for a PC with an ATI graphic card. In this way you can build a collection of PC-specific xorg.conf_* files.

For example, when changing the USB device from my laptop to the desktop PC, I copy/overwrite the xorg.conf_mydesktop to /etc/X11/xorg.conf, restart the X-server, and have 3D acceleration on my desktop PC. This may seem a bit clumsy but it works. This process could probably be automated with a small script which detects the PC in use and then pre-selects the appropriate xorg.conf_* file before starting the X-server.

If you go to a new PC you may have to reconfigure the X-server settings in the PCLinuxOS Control Center. In case you are unfortunate and X does not start at all, you can always go back to the console, become root, and issue the command, video which will give you an ncurses driven interface to setup your graphical server. If this does not help, you can issue the command do-vesa which creates a very basic but workable xorg.conf for virtually any hardware. Finally, enter the command startx in the console and the X-server should be back alive.

Clone a customized PCLOS USB device installation.

This will save you time and effort to setup the same installation on a second device and instead will quickly provide a ready-to-use USB flash drive, a nice present for your friends to promote and use PCLOS. Attach both, the USB device with the installation and an empty or new USB device to a running PCLOS system. The cloning will be done with the command, dd and you must be very careful to specify the correct mount points for each drive. If you get them wrong you will simply overwrite the installed USB device (or even your own hard drive!!!) with plain nothing... If both USB devices are identical, for example two USB sticks of the same type, then you can clone to entire disk using the command:

dd if=/dev/sdb of=/dev/sdc conv=notrunc,noerror

Here the input file (if) having the Linux installation is sdb and the output file (of) is the empty USB device, sdc. Again, please be extra sure to use the correct settings for if and of! The dd command is very powerful and should only be used if you are really sure what you are doing. Alternatively to cloning you could use dd
to create an iso-image of your USB-installation. This backup can then be stored on your PC and easily mounted, viewed, and edited, if needed. An extensive overview of the command `dd` including sample applications can be found here. Note that cloning an entire disk can take some time, especially when writing to flash drives, for example cloning the 16GB flash drive took about one hour.

Add even more applications...

You need an application which is only available in MS-Windows? Try to install and run it with wine (available in Synaptic/Smart) or with its commercial variant Crossover. If this is still not enough you could install a virtualization software, for example VirtualBox (available in Synaptic/Smart) to your external USB hard drive and use it to setup a complete operating system and its applications. Note that for this to work the host PC should provide at least 2GB of RAM, the more the better, but

we all love to hi-jack the great Vista compatible hardware, right?

4) Final remarks

In contrast to a USB2 connected external hard disk drive the performance of a flash drive is really slow. For example, the installation of a full update to MiniME today, took 10 minutes on the external hard disk but more than 2 hours on the flash drive. So, it's fun to show that it works from a flash drive but that's about it. The clear winner is the external hard disk, they work great, are fast and cheap. For less than $50.00 you can have a full-blown, portable PC in your pocket. A huge THANKS to Texstar & the Ripper Gang for providing us such an excellent Linux distribution and to Old-Polack for proofreading this article!

Now, have fun and enjoy PCLOS on your external hard disk!
I have a few Windows applications that need to run on their native OS. I've tried running them with WINE, and it wasn't pretty...

My laptop is dual-boot PCLinuxOS and WinXP, and I've been thinking about some kind of virtual machine as an alternative. So the article on VirtualBox really caught my interest!

It was mostly as easy as the article implied. I only ran into one issue as my version of XP is an upgrade and requires a CD from a previous version. It took me a few minutes (and attempts) to figure out the process to mount both the ISO and the CD! After that, everything was smooth sailing!

But I think I'll need more RAM...

Thanks!

Tim Kearsley.
I had an interesting experience this week. I was having a speed problem with my ISP (WildBlue satellite) so I gave their friendly tech support a call. After helping me with my problem I was informed that as of 1 January they would not support me in the future unless I ran XP or Visa. They will not even support the older versions of windows products (98,ME, etc.).

It's a security issue don't you know. It actually sounds to me as though Micro$oft has put WildBlue into their pocket.

I found another ISP (slower and a little more expensive) but I'm of the mind that if I'm a customer I should get support - security issue
my butt.

Jim Lees

BRIGHTEN the 'PUTER'

Brighten the 'puter where you are Install PCLOS from ol' Tex StarAll the Ripper Gang will guide you from afar So brighten the 'puter where you are

If you tried the other distros then you will knowThat configuring them is a bit bizarre They will only bring you a bit of woe So brighten the 'puter where you are

Brighten the 'puter where you are Install PCLOS from ol' Tex StarAll the Ripper Gang will guide you from afar So brighten the 'puter where you are

Come to the forum for fun and cheer You'll be successful though no cigar Everyone will help you have no fear So brighten the 'puter where you are

Brighten the 'puter where you are Install PCLOS from ol' Tex StarAll the Ripper Gang will guide you from afar So brighten the 'puter where you are

Brighten the 'puter where you are Install PCLOS from ol' Tex StarAll the Ripper Gang will guide you from afar So brighten the 'puter where you are

Because BIGGER isn't always better...
by Papawoob

Just thought I would try and bring everyone a list of currently active PCLinuxOS based distros. If I have missed any, I apologize. If anyone knows of any others that are being actively developed please drop me a note at the Magazine website or at Papawoob@pclosmag.com.

CAElinux

CAElinux is based on PCLinuxOS and is designed for computer-aided engineering. Based on the open-source CAE softwares Salomé & Code_Aster, you can load STEP / IGES geometry in Salomé and start partitioning and meshing your problem in just 5 minutes.

Granular Linux

Granular Linux is an easy-to-use, desktop Linux distribution based on PCLinuxOS. Its main features are a carefully selected set of applications for common tasks, the ability to customize the distribution, and the inclusion of two popular desktop environments - the flexible KDE and the lightweight Xfce.

Karoshi

Karoshi is a free and open source school server operating system based on PCLinuxOS. Karoshi provides a simple graphical interface that allows for quick installation, setup and maintenance of a network.

Ruby on Rails

Rails Live CD is a specialist distribution providing a pre-configured and fully operating Ruby on Rails development environment on a bootable CD. The distribution is derived from PCLinuxOS.

SAM Linux Desktop

SAM Linux Desktop, a live and installation CD based on PCLinuxOS, is an easy-to-use, fast and clean XFCE Linux desktop for home users. The distribution is enhanced by several popular non-free applications, such as Macromedia Flash Plugin, Java and RealPlayer.

VideoLinux

VideoLinux is a PCLinuxOS-based distribution with focus on DVD backups, video encoding and transcoding, DVD authoring, format conversion and pretty much anything else you want to do with video.
**TinyMe**

TinyMe 2008.0 “Final” has been released! TinyMe is a PCLinuxOS-based distribution, which is targeted at older computers and people who want a very light and fast desktop environment. Although TinyMe comes as a small, 200MB ISO, it provides tools for most all of your everyday wants and needs.

**PCFluxboxOS**

PCFluxboxOS is a series of remasters of PCLinuxOS catering for different end-user needs. All the following remasters are installable live-CDs and all come with the i586 ‘Legacy’ Kernel 2.6.18.8 for increased compatibility with older hardware. Newer kernels can be installed via Synaptic.

**TinyFlux - Version 1.0**

PCFluxboxOS 2008 is currently under development and release should tie in with the release of PCLinuxOS 2008. The aim for the next release will be to create a truly modular operating system using metapackages to enable users to quickly and easily add groups of applications, all fully configured for maximum performance with your Fluxbox desktop. See TinyFluxdownloads page for full details.

**MidiFlux – 0.6b**

A large selection of applications in a relatively small ISO 340MB in size.

**Keldix Linux**

Keldix is a Linux distribution primarily for the Small business Office and Home Office (SOHO) market. Keldix is a live-DVD built on PCLinuxOS.

**PCLOS Gnome**

All new bootsplash, backgrounds, and really nice features, upgraded to a great looking operating system, the best out-of-the-box look and user experience possible!

**Business Edition Linux (BEL)**

BEL or Business Edition Linux is a business implementation of PCLinuxOS 2007. Our goal is to provide solutions for small business needs using one of the easiest to use Linux Distributions available.

**MythTVOS**

MythTVOS 2008 is based on MiniMe 2008 and has MythTV and all plugins installed.
and (pre)configured. Just boot from the liveCD, select your TV / SAT / CABLE card and scan for channels…

**EeePCLinuxOS**

EeePCLinuxOS is a PCLinuxOS remaster specifically for the EeePC.

**PCLinux Educator**

A new name and a new, initial, new way of releasing. EduLos will now be called PCLinux Educator and will in first instance be distributed as a 'meta'package. This means that you can just use your vanilla PCLinuxOS setup and in Synaptic select one package that will immediately install all softwares that we think are useful as a primary student, a secondary student or an educator.

**MiniMe**

This is a minimal LiveCD that is bootable, plus it can be installed. Add in your own background, window decoration, localizations, preferred applications and supporting libraries to fully trick out your desktop. In addition, you can remaster your own custom version of PCLinuxOS. Have fun! You can find the .iso image under the Downloads button at: http://www.pclinuxos.com/index.php?option=com_frontpage&Itemid=1

**Linux EduCD**

LinuxEduCD is education-scientist version of livecd type. It can be installed on hard drive but it is not a must. System is maximally simple because for learning purposes in schools. It contains education, graphical, business and multimedia packets.

**DFPE**

Pre-installed packages for everything concerning the managing and editing of digital images. These are in almost all cases standard PCLOS packages out of the official repositories. In only one case, a package has been upgraded to a newer version and the upgraded packages have been provided upstream to the PCLOS development team.

**SaxenOS 2008**

SaxenOS is a full fledged Linux office desktop and based on PCLinuxOS. SaxenOS 2008 isn’t as lightweight as the former versions. The full OpenOffice package was added to the speedy XFCE desktop. Also, multimedia apps and games were cut in favour of productivity.
**Bugnux**

Bugnux is a complete Linux (Mandriva) distribution that runs from a single bootable CD and runs entirely in RAM. Bugnux contains an extensive set of Open Source software testing tools that can be used for functional and performance testing. Standalone tools to test GUI applications and Mozilla Firefox extensions pre-installed to aid in web application testing have been packaged. This virtually can turn any PC into black-box testing device without having to install any software.